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Product Registration

Please take time out to register your new product.

Details are included in the General Information Chapter

You can even do it online at:-

www.digitimer.com/register

Digitimer Ltd. 2 of 53 Copyright © 2014
File Ref: N:\Docs\Company\Manuals\DS5\ISSUE-7\D125-MAN_v7.odt Last Revised: March 5, 2014

http://www.digitimer.com/register


DS5 Isolated Bipolar Constant Current Stimulator DS5 Operator's Manual 7.0

Table of Contents

CHAPTER 1
GENERAL INFORMATION..............................................................................................7

Product Description & Intended Usage...............................................................7

Precautions & Warnings......................................................................................8

Operator’s Manual....................................................................................8
Indications for Use...................................................................................8
Risks to Patient Safety..............................................................................8
Patient Exclusion Criteria...........................................................................8
Explosion and Fire....................................................................................9
High Voltages...........................................................................................9
Damage...................................................................................................9
Temperature............................................................................................9
Moisture...................................................................................................9
Input/Output Connectors..........................................................................9
Electrical Interference...............................................................................9

Regulatory Statements......................................................................................10

EU Declaration of Conformity............................................................................10
EN 60601-1:2006 + A1:2013 Classifications.......................................................11
Environmental..................................................................................................11

Cleaning, Maintenance & Servicing...................................................................11

Modification Status............................................................................................11

Unpacking..........................................................................................................12

Supplied Accessories........................................................................................12
Optional Accessories.........................................................................................12
Mains Connections...........................................................................................12
Mains Plug Connections....................................................................................13
Mains Plug Fuse...............................................................................................13
Mains Voltage Selector.....................................................................................13
Mains Inlet Fuses.............................................................................................13

Product Registration..........................................................................................14

Why Register Your Purchase?...........................................................................14
How to Register Your Purchase.........................................................................14
Product Announcement Mailing List...................................................................14

Contact Addresses.............................................................................................15

Manufacturer...................................................................................................15
Main Representatives.......................................................................................15

Purchase Information........................................................................................16

Specifications.....................................................................................................17

Digitimer Ltd. 3 of 53 Copyright © 2014
File Ref: N:\Docs\Company\Manuals\DS5\ISSUE-7\D125-MAN_v7.odt Last Revised: March 5, 2014



DS5 Isolated Bipolar Constant Current Stimulator DS5 Operator's Manual 7.0

Warranty Information........................................................................................18

Limited Warranty.............................................................................................18
Obtaining Warranty Service..............................................................................18
Product change or discontinuation.....................................................................18

CHAPTER 2
HARDWARE INSTALLATION........................................................................................19

Tour of the Hardware.........................................................................................19

Introduction.....................................................................................................19
Front Panel Components...................................................................................19
Front Panel Symbols.........................................................................................20
Rear Panel Components....................................................................................21
Rear Panel Symbols..........................................................................................21
Audible Alerts & Warnings................................................................................22

Initial Hardware Check......................................................................................22

CHAPTER 3
CONFIGURATION AND OPERATION............................................................................25

The Main Operating Screen................................................................................25

Main Operating Screen Components & Icons......................................................25

Configuring the DS5...........................................................................................27

Defining the Required Input Voltage Range..............................................27
Defining the Required Output Current Range............................................27
Adjusting the Display Contrast.................................................................27
Turning the LCD Backlight On and Off......................................................28
Enabling and Disabling the Audible “Information” Alerts............................28
Enabling and Disabling the Output Limits.................................................28
Maintenance Options..............................................................................28

Output Limits.....................................................................................................28

Limits and the Definition of a Pulse...................................................................29
Exceeding an Enabled Limit..............................................................................29
Exceeding a Disabled Limit...............................................................................29

Hardware Connections.......................................................................................29

Voltage Input Connection.................................................................................29
Monitor Output Connections..............................................................................30
USB Connection...............................................................................................30
Connecting to a Dummy Load...........................................................................31
Patient Connection...........................................................................................31

Selecting Appropriate Stimulation Electrodes............................................31
Electrode Placement Protocols.................................................................32

Applying a Stimulation Protocol........................................................................32

Introduction.....................................................................................................32
The Autozero Function......................................................................................32

Digitimer Ltd. 4 of 53 Copyright © 2014
File Ref: N:\Docs\Company\Manuals\DS5\ISSUE-7\D125-MAN_v7.odt Last Revised: March 5, 2014



DS5 Isolated Bipolar Constant Current Stimulator DS5 Operator's Manual 7.0

Enabling & Disabling the Stimulator Output........................................................32
Enabling Upon Startup............................................................................33
Resetting & Re-enabling After Output Limit Error......................................33
Terminating a Stimulation Protocol..........................................................33

Bibliography.......................................................................................................34

CHAPTER 4
TECHNICAL ANNEXES.................................................................................................35

ANNEX 1:- Recurrent Testing of the DS5...........................................................35

Test Procedure.................................................................................................35
Visual Inspection....................................................................................35
Electrical Tests.......................................................................................35
Functional Test.......................................................................................36
Evaluation, Documentation and Preparation for Normal Use......................36

ANNEX 2:- Installing & Using the DS5 User Interface (DS5 UI) Software.......37

Installation of the DS5 UI Software...................................................................37
Using the DS5 UI Software...............................................................................41

DS5 Device List......................................................................................41
DS5 Console...........................................................................................42
Menu & Tool Bar.....................................................................................43
Copying Profiles to another Computer......................................................45
Meters...................................................................................................46
Status Indicator Icons.............................................................................46

ANNEX 3:- Guidance & Declarations on Electromagnetic Compatibility...........48

Electromagnetic Emissions (Table 201)..............................................................48
Electromagnetic Immunity (Table 202)..............................................................49
Electromagnetic Immunity (Table 204)..............................................................50
Recommended separation distances between portable & mobile RF 
communications equipment & the Digitimer DS5 (Table 206)..............................51

ANNEX 4:- Guidance on System Integration.....................................................52

Digitimer Ltd. 5 of 53 Copyright © 2014
File Ref: N:\Docs\Company\Manuals\DS5\ISSUE-7\D125-MAN_v7.odt Last Revised: March 5, 2014



DS5 Isolated Bipolar Constant Current Stimulator DS5 Operator's Manual 7.0

Digitimer Ltd. 6 of 53 Copyright © 2014
File Ref: N:\Docs\Company\Manuals\DS5\ISSUE-7\D125-MAN_v7.odt Last Revised: March 5, 2014



DS5 Isolated Bipolar Constant Current Stimulator DS5 Operator's Manual 7.0

CHAPTER 1CHAPTER 1
GENERAL INFORMATIONGENERAL INFORMATION

Product Description & Intended Usage

The  DS5  is  an  isolated  bipolar  constant  current
electrical  stimulator that has been developed for the
new and increasingly important field of clinical nerve
excitability  testing.   These  studies,  including
electrotonus and threshold electrotonus, are giving us
added understanding of human nerve excitability and
the  pathophysiology  of  diseases  such  as  diabetic
neuropathy,  carpal  tunnel  syndrome  (CTS),
amyotrophic  lateral  sclerosis  (ALS),  multifocal  motor
neuropathy  (MMN),  motor  neurone  disease  (MND)
taxolcisplatin neuropathy and neuromyotonia.

Unlike  many electrical  stimulators,  the  DS5 is  not  a
traditional "square wave pulse stimulator", instead, it
produces  an  isolated  constant  current  stimulus
proportional to a voltage applied at its input, with the
shape of the input waveform describing the shape of
the stimulus.  As a result, when driven by a compatible

computer based digital  to analogue interface, the DS5 is capable of generating a stimulus consisting of
multiple components including sine waves, ramps, square waves or totally arbitrary waveforms.  Patient
safety is assured at all times by the implementation of safety features which, amongst other things, limit the
amount of energy passed to the subject.

The DS5 stimulator has four input voltage ranges (±1V, ± 2.5V, ±5V, ±10V) making it widely compatible
with signal generating hardware.  The input voltage range and the output current range (±10mA, ±25mA
or ±50mA) are selected via the controls on the front of the stimulator.  On the rear of the device are three
BNC sockets, one accepting the voltage input waveform, the other two providing current and voltage output
monitors, allowing the stimulus waveform parameters to be fed into a data acquisition system so they can
be recorded alongside your EMG data.  Although the DS5 has been primarily designed for clinical studies of
peripheral  nerves  using  threshold  tracking  techniques,  because  the  unit  provides  a  current  output
proportional to the voltage input and can deliver up to ±50mA (from a source of greater than ±100V), it
should appeal to any researchers wishing to safely apply a computer controlled constant current stimulus to
a patient or research volunteer.

The DS5 meets all the requirements of the Medical Device Directive (MDD) by implementing the EN 60601
Standard.   The Digitimer DS5 stimulator is  intended to be used by persons trained in its use, who are
expected to be familiar with the principles and safety issues of electrical stimulation.  Users should be able to
operate  the  DS5  stimulator,  the  controlling  software,  and  any  associated  instruments  correctly  before
carrying out any patient or human volunteer studies.  The DS5 stimulator is not intended for use in life
support situations, or in situations where improper operation or failure of the DS5 stimulator can result in
personal injury to user or patient.
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Digitimer Limited makes no representation that the design, implementation, testing or manufacture of the
DS5 stimulator meets more than reasonable standards for use as a medical  product.   As stated in the
Digitimer Limited Warranty Statement, supplied with each product, “Digitimer Limited Expressly disclaims all
warranties to buyer except the limited warranty set forth therein, including without limitation to any and all
implied warranties of merchantability and fitness for a particular purpose.”

Precautions & Warnings

Operator’s Manual

Carefully study this Operator’s Manual before using the DS5 Bipolar Constant Current Stimulator.

Indications for Use

The Digitimer DS5 is a stimulator intended to be used to apply an electrical stimulus to a patient by means
of skin electrodes for the purpose of measuring the evoked response.

It is intended for use during neurological monitoring and assessment in a clinical environment.

It  is  intended for  use by trained personnel  either competent  to  apply  appropriate  stimuli  or  under the
supervision and instruction of one who is.

Risks to Patient Safety

 Stimulating electrodes should not be placed thoracically or trans-thoracically as this may increase
the risk of cardiac fibrillation.  A warning to this effect is given on the outside of the DS5.

 Care should be taken when selecting appropriate stimulating electrodes.  If the current density of
the chosen electrode is greater than 2mA rms/cm2 then the operator should pay extra attention to
stimulus parameters to ensure that the patient does not suffer burns at the stimulation site.

 Simultaneous connection of a patient to the DS5 and high frequency surgical equipment may result
in burns at the site of stimulation and possible damage to the stimulator.

 Operation of the DS5 in close proximity (e.g. 1m) to a shortware or microwave therapy equipment
may produce instability in the stimulator output.

 The  DS5  is  not  suitable  for  use  in  close  proximity  to  extreme magnetic  fields,  such  as  those
generated by MRI scanners.

Patient Exclusion Criteria

Patients fitted with an implanted electronic device such as a cardiac pacemaker should NOT be subjected to
stimulation unless specialist medical opinion has been obtained.
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Explosion and Fire

The DS5 must not be used in an explosive atmosphere or in the presence of flammable anaesthetic gasses.

High Voltages

Dangerous voltages are present within this unit.  Do not remove covers, and refer servicing a Digitimer
representative.

Damage

The DS5 and/or any accessories must not be used if there are any signs of external damage.

Temperature

The DS5 and/or accessories should be stored or transported at temperatures between -40°C and +70°C.
The recommended usage temperature range is between +10°C and 40°C.

Moisture

The DS5 and/or any accessories must not be used if any parts are wet or damp.

Input/Output Connectors

Only equipment that complies with EN(IEC) 60601 (Medical Equipment), EN(IEC) 60950 (IT Equipment) or
EN(IEC)  61010 (Laboratory  Equipment) should be connected to  the DS5 input/output  connectors.   See
Chapter 4, Annex 4 for guidance on choice of equipment and system integration.

Electrical Interference

This unit has been fully tested for EMC conformity of Medical Devices, however, special precautions need to
be taken in relation to Electromagnetic Compatibility (EMC) when installing medical electrical equipment.
(see Guidance on Electromagnetic Compatibility (Chapter 4, Annex 3) for further technical information).

 This unit should NOT be used near radio transmitters as RF equipment can affect medical electrical
equipment.  If any ‘strange’ behaviour of the unit is noted, discontinue use immediately and refer to
a qualified EMC engineer.

 The DS5 stimulator should not be used adjacent to or stacked with other equipment.  If such use is
required, then the behaviour of the stimulator should be monitored to confirm normal operation in
this configuration.

 All cables (except patient leads) connected to the DS5 should be no longer than 3 metres in length.
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Regulatory Statements

EU Declaration of Conformity
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EN 60601-1:2006 + A1:2013 Classifications

 This equipment is CLASS I with TYPE BF Applied Parts.

 This equipment is NOT sealed against any ingress of water and is therefore IPX0.

 This equipment is NOT intended to be used sterile.  If it is necessary to remove contamination from
the  surface  of  the  equipment,  an  alcohol  moistened  cloth  may  be  used.   Sterilisation  of  any
electrodes should be performed according to the recommendations from their manufacturer.

 This equipment must NOT be used in the presence of flammable anaesthetic gases.

 This equipment is rated for CONTINUOUS operation.

Environmental

This unit does not produce any waste.  As with all electronic devices, at the end of its life it should be
disposed of by a registered waste contractor who is made aware of its nature.

Cleaning, Maintenance & Servicing

If the stimulator requires cleaning, it should be unplugged from the mains power supply and wiped with a
damp cloth.

This  equipment  does  not  require  any  regular  maintenance  but  Digitimer  recommends  that  the  DS5  is
returned to the factory for  inspection and re-testing every 2 years.   Please contact  us for  a reference
number and instructions before despatching the unit.

For on-site testing, a guide to recurrent testing procedures is given in Chapter 4, Annex 1.

Before each use - The case and all leads should be inspected for any damage.  The equipment (or the lead)
should be sent for repair if any damage is found.

For all servicing requirements please contact Digitimer, who can advice on best course of action.  Digitimer
also offer to supply a service manual (chargeable) to fully qualified, and certified, service repair centres.

Modification Status

The green and white serial number label affixed to the rear of each DS5 contains the unique serial number
of that unit.  This serial number should be quoted whenever technical support is requested from Digitimer or
one of our representatives.

The DS5 stimulator has serial numbers of the following format: DS5-72-2006.  The last 4 digits of the serial
number denote the year of manufacture.

The lower section of the label contains the “MOD. RECORD STATUS” (Modification Record Status) which
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indicates the build status of the unit and any modifications that have been subsequently performed to the
unit. 

At the time of writing, no changes to the DS5 have caused a rise in the MOD RECORD STATUS, hence no
numbers are crossed out.

Unpacking

After unpacking the DS5 stimulator from the shipping carton, please inspect each piece for any sign of
shipping damage.  Please contact the carrier and your distributor, or Digitimer Limited, immediately if there
is any damage.  Do not dispose of the shipping carton, as the carrier will want to examine it in order to
process a damage claim.  Digitimer Limited and their distributors insure all  shipments to cover shipping
damage.

It is also advisable to keep the shipping carton in the event that the instrument needs to be returned for
service.

Supplied Accessories

The following items should have been packed with your DS5 stimulator:-

 Mains (Power) Lead (Cord). 

 USB Connection Cable (Please refer to Chapter 4, Annex 2 before connecting).

 Operator’s Manual (this document).

 Test Record Sheet

Please note that the USB cable supplied is specifically for use with the DS5.  USB cables from other suppliers
are NOT suitable for use with this stimulator and may result in increased EMC emissions or decreased EMC
immunity.

Optional Accessories

In order to facilitate electrode connection we offer the  D185-HB4 Electrode Extension Cable.   This
provides a 4.5m (14.5ft) extension of the patient output sockets (4mm shrouded) terminating in a pair (2) of
DIN 42 802-1 1.5mm “Touch Proof” sockets that are colour coded to the original sockets.

The D185-HB4 is  specifically designed to meet the requirements of EN(IEC) 60601 and is suitable for use
with our D185, DS7A and DS5 stimulators.

Mains Connections

The DS5 is shipped complete with a safety tested mains lead (fitted with a suitable moulded mains plug) to
most countries.

If the mains plug supplied is not suitable please advise Digitimer of the correct plug for your country.

As it is not possible to obtain certain moulded mains plugs in the UK we will supply a mains lead with a
British plug in these cases.
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Mains Plug Connections

If you have to remove the fitted plug to connect your own plug, the connections are:-

Line or Hot - Brown

Neutral – Blue

Earth or Ground – Green/Yellow

A mains plug should be used which is so constructed that if the lead is pulled the earth/ground wire cannot
come into contact with the line or neutral pins.

This instrument MUST be Earthed/Grounded.

Mains Plug Fuse

If it is possible to fit a fuse into the mains plug, this should be of the correct style and be rated at 3  Amps.

Mains Voltage Selector

The DS5 mains voltage selector should be correctly configured for the local mains voltage supply.  Four
voltage  options  are  available  (240V,  200V,  120V  and  100V)  and  these  are  selected  by  appropriately
positioning both jumpers located in the “Voltage Selector” panel on the rear panel of the DS5.

Mains Voltage
Setting 

Jumper
Positions

240V
(e.g. Europe & Australia)

 

200V
(e.g. Japan 200V)

 

120V
(e.g. USA & Canada)

 

100V
(e.g. Japan 100V)

 

Mains Inlet Fuses

Check that the correct fuses have been inserted for your supply voltage.  The factory setting is 200-240 volts
and the alternative is 100-120V.

Mains Voltage Correct Fuse

100-120V T 500mA L

200-240V T 250mA L

If replacing these fuses, please ensure the correct size, rating and type is used as a replacement.
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Product Registration

For a speedy response to all your questions now and in the future, please take time out to register your new
DS5 stimulator at www.digitimer.com/register now!  Product registration permits us to quickly advise you of
any safety matters or new product information.  This web address is your point of contact for all questions
regarding the DS5.  The contents of this site are now growing rapidly, so please bookmark it so that you can
visit it regularly to check out the new items.

Why Register Your Purchase?

Digitimer  periodically  offers  enhancements  and  firmware  updates  to  our  products.   Without  product
registration,  users of  our products  may miss out on announcements of important  enhancements to the
products that they are using.  Digitimer Limited does not make our customer list available to anyone else.
Any information that you provide to us is strictly confidential.

How to Register Your Purchase

Product  registration  can  be  accomplished  in  two  ways.   You  may  fill  out  and  mail  in  the  product
registration/warranty card supplied with each Digitimer Limited product.  You may also register on-line at
our www.digitimer.com/register website.

Product Announcement Mailing List

Digitimer has E-mailing lists  which  we use as our primary  outlet  for  announcements of  new products,
product enhancements and product updates.  We strongly recommend that all users of our products sign up
for  the  list  that  is  most  appropriate  to  their  area  of  interest.   E-mail  is  kept  to  a  minimum and  list
membership is kept in the strictest confidence.  Only Digitimer Limited can send mail to members of our e-
mailing lists.

You may join the DS5 mailing list through our www.digitimer.com/register website.
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Contact Addresses

Manufacturer
Digitimer Limited
37 Hydeway
Welwyn Garden City
AL7 3BE
UK
Telephone: (UK)  01707 328347 (Int.)  +44 1707 328347
Fax: (UK)  01707 373153 (Int.)  +44 1707 373153
E-mail: sales@digitimer.com or technical@digitimer.com

Website: www.digitimer.com

Main Representatives

USA: MEPs, LLC
One East Broward Blvd.
Suite 700
Fort Lauderdale, FL 33301
Telephone: (954) 713 8017
Fax: (954) 523 1911

Japan: Miyuki Giken Co. Ltd
Food Hygiene Association Laboratory 6F
2-5-47 Tadao
Machida
Tokyo 194-0035
Telephone: +81 (0)42-789-6022
Fax: +81 (0)42-789-6195

Germany: Helmut Wehking MedicalProducts
Neuberg 1-b
D-65193 Wiesbaden
Telephone: +49 (0) 611 185 1944
Fax: +49 (0) 611 185 1946
E-mail: helmutwehking@wehking-med.de

Please contact Digitimer for information regarding representation in other countries.
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Purchase Information

A record of salient information will aid the operator should it be required in the future:-

Date of Purchase:

Dealer:

Dealers Telephone Number:

Dealers Fax Number:

Dealers E-mail Address:

Contact Name at Dealer:

Serial Number of Unit:

Other Notes (Service/Warranty Information etc):
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Specifications

Output: Bipolar  constant  current  proportional  to  the  input  voltage  (+ve  input  voltage
gives rise to an output current where RED socket becomes +ve with respect to 
BLACK socket).

Output Ranges: ±10; ±25; ±50 mA for a full scale input

Input Ranges: ±1; ±2.5; ±5; ±10 V full scale

Freq. Response: to 20kHz (for the maximum output from a sinusoidal input)

Connections: Output - 4mm shrouded, touch-proof sockets (red and black) on 3/4” centres

Monitor - Rear panel BNC sockets for “delivered current” and “applied voltage”

Input - Rear panel BNC socket

Firmware Update - USB socket on rear panel

Controls: Four front panel push buttons labelled on LCD

Output – On/Off-Reset – Momentary Action Toggle Switch

Safety Limits: 50mJ/300mJ pulse energy

50µA average “idle” current

10mA average pulse current

50mA peak current

1s/5s maximum pulse duration

Indicators: Power ON LED Green

Warning LED Amber

LCD Display for setting up and checking:

- Peak current delivered* - Input voltage range

- Output current range - Peak Voltage*

- Error warnings - Out of compliance

- Pulse energy (PE) - Pulse duration (PD)

- Average idle current (AvL) - Average pulse current (AvH)

Software: Microsoft  WindowsTM compatible  DS5  User  Interface  (USB  control)
software (Windows XP onwards).

Power: 100V, 120V, 200V or 240V (externally selected), 47-63Hz, 35VA

Classification: Class I with Type BF applied part

Safety: EN(IEC) 60601

Dimensions: 225mm x 100mm x 255mm (width x height x depth)

Weight: 4kg (approx.)

* These values are displayed graphically NOT numerically* These values are displayed graphically NOT numerically
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Warranty Information

Limited Warranty

Digitimer Limited warrants to the first purchaser, for a period of one year from the date of purchase, that
this Digitimer instrument (hereafter referred to as the “Product”) will be free from defective workmanship
and materials, and agrees that it will, at its option, either repair the defect or replace the defective Product
or part  thereof at no charge to the purchaser for parts and labour.  The Product must be returned to
Digitimer Limited, carriage paid and insured.  Digitimer Limited will return the Product, carriage paid and
insured, in the most appropriate method as determined by Digitimer Limited.  If a faster shipping service is
desired by the customer, any additional special delivery expenses must be paid by the customer.

This warranty does not apply to shipping damage.  Digitimer Limited fully insures all shipments.  Any claims
of damage upon receipt must be filed with the carrier and Digitimer Limited immediately.

This warranty does not apply to any exterior appearance item of the Product which has been damaged or
defaced, which has been subjected to misuse and abuse, abnormal service or handling, or which has been
altered or modified in design or construction.

This warranty does not apply to any interconnection cables supplied with the Product.

This warranty does not apply if any unauthorised repairs, modifications or alterations have been made to the
Product.

No sales organisations, other than Digitimer Limited itself, are authorised to make any warranties other than
those described above, or to extend the duration of any warranties beyond the time period described above
on the behalf  of Digitimer Limited.  If Digitimer Limited agrees to such a modification of this warranty,
Digitimer will furnish a modified copy of this agreement, which must be presented if a claim is being made
under these modified terms.

Obtaining Warranty Service

Warranty service of this Product can be obtained by returning the Product, carriage paid and insured, to
Digitimer Limited, or the Distributor from whom the equipment was purchased.  Prior authorisation before
shipping the product is advised for the most expedient service.

Product change or discontinuation

Digitimer reserve the right to discontinue any instrument or to change its specification without notice, and
without responsibility for incorporating changes in instruments already sold.
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CHAPTER 2CHAPTER 2
HARDWARE INSTALLATIONHARDWARE INSTALLATION

Tour of the Hardware

Introduction

The DS5 is an isolated bipolar constant current stimulator specifically designed for studies of the peripheral
nervous  system in  both  diagnostic  and  research  settings  and  is  ideal  for  excitability  studies  based on
threshold tracking protocols.  Unlike other percutaneous nerve stimulators such as our own DS7A, the DS5
does not produce a traditional  “square” stimulus pulse but instead is  able to  receive a bipolar  voltage
waveform from another device and convert this into a bipolar constant current stimulus of the same shape
and time course.

For optimum flexibility, the DS5 can accept four voltage input ranges (±1V, ±2.5V, ±5V, ±10V) from the
waveform source, which it uses to produce an isolated output current up to a maximum ±50mA for patient
stimulation.  The input voltage signal is fed into the DS5 via a BNC socket on the rear of the stimulator.  The
other pair of BNC sockets, which are used for stimulus monitoring, output a voltage waveform proportional
to the actual stimulus voltage or current supplied to the patient.

Appropriate stimulation electrodes should be connected via the pair of 4mm touch proof output sockets (red
and black) on the front of the unit or 1.5mm DIN 42 802-1  style connectors  via the optional D185-HB4
Electrode Extension Cable.

Stimulus parameters and settings, including the input and output ranges are displayed on a backlit  LCD
screen on the front of the unit.  Modification of these parameters is made possible by use of the function
keys (F1 to F4) situated at each corner of the display screen.

The front panel of the DS5 also features an output enable/disable switch, as well as both power and warning
LEDs.  The rear of the DS5 includes an equipotential connection point, mains IEC inlet (power) socket, fuses,
mains voltage selector and a mains on/off switch.

Front Panel Components

1. Function Keys - Numbered F1 to F4.  These keys are arranged at the four corners of the LCD
display.   Their  functions  are  dynamically  assigned  depending  upon the  status  of  the  DS5  LCD
display.

2. Green Power LED - Indicates when the DS5 rear panel switch is in the ON position.

3. Illuminated LCD Display - This is the primary operator interface, displaying all current operating
conditions as well as F key assignments, stimulation data and configuration menus.

4. Red & Black Isolated Output Sockets (4mm touch proof type) - The Red will go positive with
respect to the Black socket when positive voltages are applied to the Voltage Input BNC socket on
the rear of the DS5.  The reverse will be true when negative voltages are applied at that socket. 

5. Output Enable/Disable/Reset Toggle Switch - This momentary action toggle switch is used to
enable, disable or reset the DS5.  Upward deflection enables the output and downward deflection
disables a previously enabled output.  Downward deflection can also be used to reset the DS5 when
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the output has been automatically disabled by a pre-set output limit being exceeded.

6. Amber Warning LED - Illuminated when the output has been disabled either by a fault condition
or due to a pre-set output limit being exceeded (cleared by a power OFF/ON and full test cycle).

Figure 2.1  Front Panel Components of the DS5 Stimulator

Front Panel Symbols
The front panel of the DS5 has several symbols which the operator should become familiar with before
starting to use the stimulator.

Upward deflection of the toggle switch 
enables the output.

Attention, consult accompanying documents.

Downward deflection of the toggle switch 
disables the output.

Consult operator documentation (this manual) 
before use of this equipment.

Type BF applied part. Output (stimulus connection to patient).

Table 2.1  DS5 Front Panel Symbols
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Rear Panel Components

1. Input - BNC Socket for a bipolar voltage input.  Full  scale voltage is switchable between ±1V,
±2.5V, ±5V and ±10V

2. Mon. Outputs - Monitor outputs providing output voltages that are proportional in shape to the
stimulus current (expressed as 1V/10mA) or voltage (expressed as 1V/20V).  These outputs are
ground referenced and isolated from the patient.

3. Control  - Type B USB socket providing a USB interface COM port to link the DS5 to a remote
personal computer running Windows 2000 or Windows XP.  This socket allows for future updates to
the DS5 firmware, as well as control of DS5 settings via the DS5 User Interface Software (refer to
Chapter 4, Annex 2 BEFORE connecting).  Only the USB cable supplied with the DS5 should be used
in this socket.

4. Mains Inlet, Mains Fusing and Power Switch Combination - NOTE - Power supply cord must
contain, and use, an Earth/Ground conductor.

5. Potential Equalisation Connector - Earth/Ground reference for unit and bonding point.  This is
to be used when the earth/ground conductor in the mains cord of all units in use cannot be relied
upon or is not available.

6. Voltage Selector – The DS5 should be set to the appropriate mains supply voltage before the
stimulator is switched on.

Figure 2.2   Rear Panel Components of the DS5 Stimulator

Rear Panel Symbols

The rear panel of the DS5 has several  symbols which the operator should become familiar with before
starting to use the stimulator.
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Digitimer has declared that this 
equipment complies with the 
medical device directive, under the 
supervision of notified body 0120 
(SGS UK Ltd).

Potential Equalisation Connector 
(PEC).

Signal Input (±10V max).  The 
voltage applied at this input 
determines the shape of the 
stimulus waveform.

o OFF (power) - Indicates OFF position 
of Mains Power switch.

Monitor Output – Voltage outputs 
which are calibrated to the stimulus 
current or voltage (see below)

I ON (power) – Indicates ON position 
of Mains Power switch.

Monitor Output (Current)
Scaling – 1V/10mA.

Control Input – USB socket for 
connection to  computer.

Monitor Output (Voltage)
Scaling – 1V/20V.

Mains inlet fuse – replace with type 
indicated for your local mains 
voltage, unless this has already been 
factory set.

Table 2.2  DS5 Rear Panel Symbols

Audible Alerts & Warnings

The DS5 produces two types of audible alert.  A high pitched “information” beep serves as confirmation that
the operator has toggled or pressed a front panel switch or button.  A deeper pitched “warning” tone
informs the operator  that  a  safety limit  has  been reached/exceeded or  that  intervention  is  required in
response to a warning icon which will be simultaneously displayed on the front panel screen.  Audible alerts
are switched on by default, but the “information” beep may be disabled by the user via the options menu.

When disabled a  icon is displayed on the front panel LCD screen.

Initial Hardware Check

Before connecting a voltage source, monitor output cables or electrodes to the DS5 it should be given an
initial check out to ensure that it is powering up correctly.

1. Ensure that the power supply switch on the rear of the DS5 is in the OFF (O) position.

2. Ensure that the mains inlet fuses installed are appropriate for your mains supply voltage and that
the voltage selector jumpers are in the correct position for your local mains supply voltage.
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3. Connect the mains power lead to the DS5 mains inlet and switch on at the wall socket.

4. Switch the power switch on the DS5 to the ON (I) position.

5. The front panel LCD screen should illuminate and the Green Power and Amber Warning LEDs should
light up.

6. After approximately 3 seconds the start-up screen should appear, displaying “Digitimer DS5”.

7. Shortly afterwards the DS5 will  run a system test, validating the firmware, stabilizing and finally
executing a self-test.   The lower half of the display should confirm that both the firmware and
hardware tests have been passed successfully, at which point the Warning LED should extinguish.  If
any errors are reported during the above tests, please discontinue use of the DS5 and
contact your local Digitimer representative for further technical advice.

Figure 2.3  Initial Main Operating Screen Display

8. Once all tests have been successfully completed the Main Operating Screen (Fig 2.3) is displayed. In
the bottom left corner of the screen a flashing   icon indicates that the DS5 is ready for auto-
zeroing using the front panel F2/AZ key.

9. We recommend that the DS5 is left switched ON for approximately one hour to “warm up” before
use.  This allows any temperature sensitive components to equilibrate.

10. The DS5 is now ready to be configured for the particular  hardware it is  to be interfaced with.
Configuration  should  be  carried  out  using  the  front  panel  Operator  Interface,  which  is  more
thoroughly discussed in Chapter 3 – Configuration and Operation.
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CHAPTER 3CHAPTER 3
CONFIGURATION AND OPERATIONCONFIGURATION AND OPERATION

The Main Operating Screen

The Main Operating Screen is the default screen when the DS5 is in use and it provides the operator with an
instant  display  of  various continuously measured parameters  as well  as  the selected input  voltage and
output current ranges.  Depending upon the status of the DS5 it will also display certain icons which are
used to warn or prompt the operator of necessary action or excessive input/output conditions.

Figure 3.1  DS5 Main Operating Screen Display

Main Operating Screen Components & Icons

Figure 3.2  Main Operating Screen Zones

The main operating screen is divided into 10 zones which are used dynamically under different conditions.
Zones F1 and F2 are generally used to indicate functions for the F1 and F2 keys, while the F3 and F4 zones
tend to be used for purely informative purposes (although they are used to indicate the scroll up and scroll
down functions of F3 and F4 in the Options Menu).  Zones A to G display various icons, text and graphs
which are fully described in Table 3.1.
Area Icon/Display F-Key Allocation or Display Icon Meaning
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F1 Pressing F1 opens the “Options Menu”.

F2

Flashing when Autozero required after timeout period.

  

Autozero not possible due to +ve and -ve pulses on the input (left).
Autozero not possible due to +ve pulses on the input (centre).
Autozero not possible due to -ve pulses on the input (right).

 

Autozero not possible due to an excessive DC offset on the input (left).
Autozero not possible due to oscillations on the input (right).

F3
Iconic display of the following adjustable DS5 settings:
Input Voltage Range:- ±1V, ±2.5V, ±5V or ±10V (shown)
Output Current Range:- ±10mA (shown), ±25mA or ±50mA

F4

Output Enabled:- Stimulation can proceed.

Output Disabled:- Autozero operation is required.

Output Disabled:- An initial DC stimulation >±10µA would result.

Output Disabled:- +ve and -ve pulses resulting in current peaks >400µA present.

Output Disabled:- +ve pulses resulting in current peaks >400µA present.

Output Disabled:- -ve pulses resulting in current peaks >400µA present.

Output Disabled:- Oscillation above +400µA or -400µA (peak) present.

A Symbol when USB link with a computer is established.

B Input Over Voltage Warning:- The three icons shown are used to indicate the polarity
of the excessive input voltage.

C
Twin horizontal bar graphs illustrate the output current (upper display) and the output voltage.  The scaling of 
the output current graph is adjusted when the output current range is changed.

D
Numerical display of the four limited parameters:- Average Low Level (baseline) Current (  ), Average High
Level (Pulse) Current (  ), Pulse Energy (  ) and Pulse Duration (  ).  If any of these are exceeded,
the stimulator output is disabled and the parameter(s) responsible will be indicated by an arrow, exclamation
mark as well as an audible warning. This area is also used to display the patient impedance (ohms).

E
Warning symbol indicating that one or more output limits has been disabled.

F
Out  of  compliance warning (i.e  the current  requested  cannot be provided due to
limitations of the compliance voltage).

G
Audio Off: - The audible information beep has been disabled.

Table 3.1  Main Operating Screen Components and Icons
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Configuring the DS5

Configuration changes are made via the options menu which is accessed from the main operating screen by
pressing the F1 key, indicated by the   icon.  To access this menu the stimulator  output  must be
disabled using the orange toggle switch and it will be necessary to re-enable the output before another
stimulation protocol can commence.  The options menu presents the operator with a scrollable list of menu
choices (F3 key for up and F4 key for down).  When an item of interest is identified, it can be selected using
F1 ( ). When required, F2 ( ) allows the operator to exit to the main operating screen.

     

Figure 3.3  Typical DS5 Options Menu Displays

Most of the choices in the options menu provide the operator with an opportunity to modify the default
settings of the DS5.  The various choices are further described below and should be carefully defined before
the DS5 is connected to any external devices or subjects.

Defining the Required Input Voltage Range

Full scale input voltage ranges are selectable between ±1V, ±2.5V, ±5V
and ±10V so that the DS5 can be configured to interface with a range of
signal  generating  hardware  devices  such  as  data  acquisition  interfaces
with D/A outputs.  F3 and F4 scroll through the choices and F1 confirms
the selection and returns to the main Options Menu.

Defining the Required Output Current Range

The  full  scale  output  current  ranges  are  selectable  between  ±10mA,
±25mA and ±50mA.  This allows the operator to limit the output to a
lower  range when carrying out  studies  which  require  a  lower  stimulus
amplitude.   F3 and F4 scroll  through the choices and F1 confirms the
selection and returns to the main Options Menu.

Adjusting the Display Contrast

The LCD screen display contrast can be increased or decreased to suit the
user.  F3 and F4 are used to scroll through the choices, while repeated
pressing of F1 will increment a change in contrast.  A default setting is
available  if  required.   F2  confirms the  choice  and returns  to  the main
options menu.

Turning the LCD Backlight On and Off

This menu item allows the operator to turn off the LCD backlight if it is not
desired.  F3 and F4 scroll through the parameter choices.  F1 accepts the
hi-lighted setting and exits to the main options screen.
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Enabling and Disabling the Audible “Information” Alerts

The  DS5  will  provide  an  “information”  beep  in  response  to  all  button
presses and switch actions by default.  It is possible for the operator to
disable the “information” beep if they wish.  F3 and F4 scroll through the
parameter choices.  F1 accepts the hi-lighted setting and exits to the main
options screen.

Enabling and Disabling the Output Limits

By default, four limited parameters are monitored by the DS5 and if the
stimulus output exceeds any of these limits, the output is disabled and the
warning LED illuminates.  This screen allows the operator to remove some
or all of these limits.  F3 and F4 scroll through the parameter choices and
F2 removes (un-ticked) or re-instates (ticked) the limit.  F1 confirms the
choices and returns to the main options menu.  Refer to the Output Limits
section below for further information.

Maintenance Options

The maintenance screen gives the operator the opportunity to access four
further screens:-

Last Reset Cause - Displays the cause of the last reset.
Factory Defaults - Restores factory defaults to all options menu settings.
Diagnostics - Provides a scrollable list of internal memory which can be 
used by Digitimer engineers for test purposes.
Exception Tests – Used by Digitimer Engineers for test purposes.
About - Details the hardware and firmware versions.

F3 and F4 scroll through the parameter choices, F1 selects the screen to 
view while F2 exits to the main options menu.

Output Limits

Patient safety is of paramount importance when designing an electrical  stimulator for clinical use.  As a
result the DS5 incorporates several layers of safety features, many of which will never be apparent to the
operator.   Amongst these are four output limits which control  stimulus pulse energy, current and pulse
duration.  However, in order to allow for a degree of clinical freedom, some output limits can be deactivated
by the operator.  It should be noted that when these limits are deactivated, they generally do not remove
the limits, they merely shift them to more flexible values, without compromising patient safety.

By default the DS5 is factory configured with four output limits enabled.  Through use of the Operator
Interface, these four limits can be toggled on and off.  The Table 3.2 gives the values for these limits and
those that are implemented when they are disabled.

Limits and the Definition of a Pulse

For the purposes of defining stimulation waveforms, the operator should note that the DS5 will identify a
stimulus  pulse  as  having  been  initiated  when  a  current  of  over  ±400µA  is  detected  at  the  output,
whereupon, the DS5 will stop monitoring the baseline current (AvL, Average Low Level Current) and start to
monitor the parameters relating to a stimulation pulse (AvH, Average Pulse Current; PD, Pulse Duration and
PE, Pulse Energy), disabling the output if any of these exceed the pre-set limits.  If the amplitude drops
below  ±400µA then  the  DS5  reverts  to  monitoring  AvL.   If  the  polarity  of  the  pulse  was  to  change
instantaneously then the DS5 would interpret this as the termination of a pulse and the initiation of another.
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Exceeding an Enabled Limit

When an enabled output limit is exceeded the stimulator output will disable, a warning beep will sound and
an  arrow  with  an  exclamation  mark  will  appear  on  the  main  operating  screen  next  to  the  exceeded
parameter.  The stimulator output will need to be re-enabled before a new stimulation protocol can begin
(see Resetting & Re-enabling After Output Limit Error).

Exceeding a Disabled Limit

When a disabled output limit is exceeded, an arrow will appear on the display next to that parameter, but
the stimulator will continue to produce an output until the higher (disabled) value or one of the other output
limits is exceeded.  At this point, the output will be disabled, an exclamation mark and an arrow will appear
next to the parameter that caused the stimulator output to disable.  As before, the stimulator output will
need to be re-enabled before a new stimulation protocol  can begin (see  Resetting & Re-enabling After
Output Limit Error).

Stimulus Parameter Enabled Disabled

Average output current (AvH) 10mA 55mA

Average Low level (baseline) current (AvL) 50µA Not Limited*

Pulse duration (PD) 1s 5s

Pulse energy limited to 50mJ (PE) 50mJ 300mJ

* If the average low level (baseline) current limit is deactivated, patient protection is maintained as any
current over 400µA is considered a pulse and would then be limited in duration, energy and average current.

Table 3.2  DS5 Output Limits

Hardware Connections

Voltage Input Connection

The DS5 will accept a voltage input of ±1V, ±2.5V, ±5V or ±10V.  For correct operation, it is important that
the DS5 is configured for the appropriate input voltage before it is used (see above).

1. The operator should first of all check what output voltage range is provided by the signal generator
or computer interface to be connected to the DS5.  This information should be available in the
manual supplied with that equipment.

2. The  DS5  input  voltage  range  should  then  be  configured  for  the  same  value  via  the  operator
interface.  Once set, a full scale input voltage will generate a full scale output current output.

3. The voltage source should then be connected to the Voltage Input BNC socket on the rear of the
DS5, using an appropriate cable.

4. Before a voltage signal is applied to the DS5, it is necessary to press the F2/AZ key to autozero the

Digitimer Ltd. 29 of 53 Copyright © 2014
File Ref: N:\Docs\Company\Manuals\DS5\ISSUE-7\D125-MAN_v7.odt Last Revised: March 5, 2014



DS5 Isolated Bipolar Constant Current Stimulator DS5 Operator's Manual 7.0

stimulator output.  This procedure ensures that any baseline voltage offset at the input socket is
nulled and does not result in a DS5 stimulus output.

Monitor Output Connections

When connected to a suitable data acquisition device, the monitor outputs allows the operator to make a
continuous record of the stimulation current and voltage.  These records can be used to relate the stimulus
time course to events observed within an evoked response.  With appropriate analysis, this data would also
allow the operator to record the output impedance throughout a study.

1. Before  proceeding,  the  operator  should  confirm  that  the  analogue  input  connection  of  the
monitoring equipment is able to accept an input voltage of up to ±10V.  If it is unclear whether the
equipment will accept this voltage range, the manufacturer of the equipment should be consulted
before any further use of the monitor feature.

2. If the operator of the DS5 is interested in monitoring the stimulus current, then the monitor output
scaling  is  1V/10mA  i.e  a  +1V  signal  at  the  current  monitor  output  will  equate  to  a  +10mA
stimulation current.  If the stimulus voltage is of more interest, then the voltage monitor output
scaling is 1V/20V.  Using these scaling factors it may be possible to calibrate the data acquisition
software being used so that the computer displays a recording of the actual stimulus current and/or
voltage.

3. Once the data acquisition system has been configured, the DS5 monitor output(s) can be connected
to the appropriate analogue input(s) of the acquisition system.

USB Connection

Digitimer provide freely downloadable DS5 User Interface (DS5 UI) software which allows the operator to
update the DS5 firmware, adjust, save and recall stimulator settings or view a “virtual DS5 front panel” on a
computer during stimulation.  Perhaps more importantly for some users, the USB connection also makes it
possible for other software to modify  DS5 settings via COM Interface.

Further details on how to download, install and use the DS5 UI are given in Chapter 4, Annex 2.

NOTE: The DS5 should NOT be connected to a computer via the USB cable until the DS5 UI Software has
been successfully installed.

Connecting to a Dummy Load

We advise all new operators of the DS5 to simulate a protocol before a human subject is used.  To do this
we suggest that the operator fabricates a “dummy load circuit”  by placing a 1kohm (11 Watt)  resistor
between the stimulus output sockets of the DS5 and applying a voltage waveform at the DS5 Voltage Input.
The resulting pulse current, energy and pulse duration information will be displayed on the main operating
screen.  The operator should take care in handling the resistor after a pulse protocol has been applied, as it
may heat up considerably during a protocol.
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Patient Connection

Before proceeding with patient connection to the stimulator output it is critically important that the operator
reads the safety precautions and warnings at the front of this operator's manual, fully appreciates their
meaning and is totally familiar with the operation of the stimulator and other equipment interfaced with it.

We recommend that the operator also carry out intended stimulation protocols with a dummy load before
carrying out any studies on human subjects.

On no account should a grounded oscilloscope or other monitoring device be connected to the
front panel output sockets of the DS5 while a patient is connected to the stimulator.

Selecting Appropriate Stimulation Electrodes

Digitimer does not supply any electrodes with the DS5 stimulator as it is expected that most operators will
already  be  familiar  with  the  type  of  electrodes  suitable  for  transcutaneous  peripheral  nerve/muscle
stimulation and will have a preferred supplier.

We do provide a range of optional accessories which include an output extension cable and these are more
thoroughly described in the Optional Accessories section of this manual.

We provide the following electrode selection guidance based on the experiences of those more familiar with
this form of electrical stimulation technique:-

Electrode Material – For patient safety, we recommend that electrodes should be of a non-polarizable
construction e.g Ag/AgCl.

Electrode Fixation – Electrodes may be of the disposable self adhesive type or reuseable taped or self
adhesive washer fixed type.  Whichever method of fixation is used, the operator should ensure that the skin
is well abraded and cleaned prior to fixation to minimise impedance. The operator should also ensure that
there is low risk of the electrode becoming detached during a stimulation protocol.  Regular visual inspection
of the electrodes in parallel with checking of the patient impedance during stimulation would be beneficial in
this regard.

Electrode Dimensions – The operator should take special care when the current density of any electrode
is greater than 2mA rms / cm2.   While electrodes with a surface area of ~1cm2 are routinely used for
peripheral  nerve  stimulation,  we would  recommend that  the  operator  uses  electrodes  with  the  largest
surface area that still allows them to adequately stimulate particular nerves with precision.

Electrode Leadwires - Electrode leadwires should be kept as short as possible so as to reduce the chance
of inadvertent trans-thoracic stimulation.  We recommend use of our  D185-HB4 Electrode Extension
Cable as this brings a pair of DIN 42 802-1, 1.5mm Touch Proof sockets closer to the subject so that
electrode lead wire can be shorter.

Electrode Placement Protocols

Correct electrode placement is determined by the location of the nerve or muscle that is being studied and
as such the operator should have adequate anatomical  knowledge to allow for the correct placement of
stimulation and recording electrodes before proceeding to use the DS5.

If  necessary  a  search  of  recent  publications  on  peripheral  nerve  stimulation  should  be  conducted.   A
bibliography is provided in this manual which may provide a good starting point for such a search, as it
includes papers by those who have used a prototype model of the DS5 stimulator.
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Applying a Stimulation Protocol

Introduction

All appropriate input and output connections should now have been made to the DS5, including connections
to a dummy load or patient.  The voltage source should be connected to the DS5 voltage input socket,  but
should not be delivering a stimulus waveform. The DS5 should have been powered ON for at least one hour
prior to use in order to equilibrate temperature sensitive components.  Whether the operator is preparing to
stimulate a patient or a “dummy load” it is necessary to Autozero the DS5 prior to enabling the stimulator
output.  Both of these steps are detailed below.

The Autozero Function

The autozero function is used to ensure that the baseline input voltage is translated into zero current at the
output even if there is a small DC offset present at the input.  Autozeroing should be carried out by pressing
the F2/AZ key once an external voltage source has been connected to the DS5, but BEFORE any stimulation
voltage is applied to this input.  The autozeroing procedure is prompted by the appearance of the autozero
timeout icon  in the F2 zone of the display upon startup, during use and whenever the output has been
disabled.

If the stimulator does not autozero when the F2/AZ key is pressed, a warning beep will sound and an icon
will be displayed in the F2 zone indicating the reason why the autozero could not be completed.  If the
autozero fails, please refer to Table 3.1 for an explanation of the displayed icon.  Once autozeroed, the
output can be enabled and a stimulation protocol can proceed.

If the output remains enabled for a 5 minute period, then the flashing autozero timeout icon re-apppears in
the F2 zone of the display, prompting the operator to autozero the unit once again.  If the operator fails to
press the F2/AZ key, the DS5 will remain enabled until the user disables the output manually or it is disabled
automatically due to an error or an output limit being exceeded.  In this way, stimulation protocols can be
completed without interruption, however, we do recommend that the DS5 is autozeroed regularly so as to
minimise the chance of the low level (baseline) current safety limit being exceeded during a study.  If the
stimulator output is disabled either manually or automatically while the autozero timeout icon is displayed, it
will not be possible to re-enable the output until the stimulator is autozeroed.

Enabling & Disabling the Stimulator Output

On the right hand side of  the DS5 front panel,  an orange momentary  action  toggle  switch  allows the
operator to enable or disable the stimulator output.  The stimulator will not pass a stimulus to a subject until
it is enabled and this can only be accomplished if there are no warning icons displayed that require user
intervention.  For example, it will not be possible to enable the output if the DS5 requires autozeroing, or if a
voltage has been detected at the voltage input socket.  A warning icon will be dispayed in the F4 zone to
indicate the reason why the output remains disabled.  Once enabled, it is possible for the external voltage
source to control the output of the stimulator.

Enabling Upon Startup

To  enable  the  stimulator  the  orange  toggle  switch  needs  to  be  pushed  transiently  upwards  (it  will
automatically return to the central position).  The unit should give an audible confirmation beep and the
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output enabled icon  should be displayed in the F4 zone of the display.  The output can be disabled at
any time by transiently pushing the orange toggle switch downwards, stimulation will cease and the output
enabled icon will disappear from the display.  We would suggest that the operator routinely disables the
output at the end of a stimulation protocol so as to minimise the chance of any inadvertent stimulation of
the patient.

Resetting & Re-enabling After Output Limit Error

When an enabled output limit is exceeded the stimulator output is automatically disabled and the amber
warning LED illuminates.  In this state the stimulator cannot be autozeroed or re-enabled until the orange
toggle switch is transiently pushed downwards – resetting the DS5.  This action extinguishes the amber
warning LED and prompts the user to autozero the input.  Once autozeroed it is possible to once again re-
enable the output by transiently pushing the toggle switch upwards.

Terminating a Stimulation Protocol

Once  a  stimulation  protocol  has  been  completed,  the  output  enable  toggle  switch  should  be  pushed
transiently downwards to disable the output and prevent any inadvertent stimulation of the subject while
other equipment is adjusted or electrodes are re-positioned.  To start a new protocol it will be necessary to
autozero the voltage input and re-enable the output as detailed above.

If any errors are reported during the actions above, please discontinue use of the DS5 and
contact your local Digitimer representative for further technical advice, advising them of the
serial number of the stimulator and the content of any error messages displayed.
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CHAPTER 4CHAPTER 4
TECHNICAL ANNEXESTECHNICAL ANNEXES

ANNEX 1:- Recurrent Testing of the DS5

Recurrent testing of medical electrical equipment is often required as part of the equipment management
policy of hospitals or other responsible organisation.  These tests may be required before the equipment is
put into service, or after fixed time intervals.

The international standard, IEC 62353 (Recurrent test and test after repair of medical electrical equipment),
suggests testing intervals.  For equipment that applies electrical energy, to directly influence the function of
nerves or muscles, as the DS5 can, the suggested test intervals should be no more than 24 months.

Every DS5 supplied is extensively tested by Digitimer before delivery.

These instructions are meant as a guide to suitably qualified test personnel, with authority to perform these
tests on behalf of the responsible organisation for the equipment involved.  They provide guidance to allow
the tests to be accomplished without causing damage to the equipment or exposing the test personnel to
risk.  They cannot and must not replace the training and experience required for testing medical electrical
equipment.

Test Procedure

Before commencing the test procedure it  is  important  to fully  understand the operation of  the DS5 by
reading the Operator's Manual.

The DS5 is a Class 1 device with Type BF applied parts.

There is no requirement, in any of these tests, to open the case of the DS5. All repair procedures should be
referred to Digitimer or a local distributor.

Visual Inspection

Visually check for any damage to the enclosure of the DS5.  Also carefully check for damage to the supply
lead and any input or output cables.

Check that the voltage selectors on the rear panel are set to suit the local supply voltage.

Check that the 2 mains fuses, housed within the appliance coupler, are of the correct rating and type for the
local supply voltage.

Check for signs of contamination or fluid spill. If fluid has entered the enclosure refer the repair to Digitimer
or it’s local distributor.

Check that the tamper-evident seals on the rear of the DS5 are unbroken and un-disturbed.  Evidence that
the enclosure has been opened may indicate the need for more extensive testing.

Electrical Tests

The electrical tests may be most easily accomplished using combination test equipment such as the Rigel
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277 Electrical Medical Safety Analyser.

Earth Resistance -  Accessible  conductive parts  are  required to  show a low impedance connection  to
protective earth.  The DS5 may be tested at currents up to 25A but the only accessible conductive parts are
the Potential Equalisation Terminal on the rear panel and the shell of the BNC connectors.

The visible shell of the USB connector MUST NOT be tested at 25A as damage will occur.  The existence of
earth continuity here may be tested only at 100mA.

Leakage Currents - Connect the DS5 to the test equipment according to the instructions for a Class 1
device with Type BF applied parts.  The applied parts of the DS5 are the red and black output terminals on
the front panel.  As they are Type BF they may be tested as one part.

Leakage current measurements should be taken with the unit switched on and the output enabled.

All of the leakage current measurements, in both normal condition and single fault condition, may be taken
with the DS5 connected as described.

Insulation Resistance - Insulation resistance may be measured using test voltages of up to 350V.

Functional Test

The DS5 completes a full self test every time that it is powered-up.  Should it be felt necessary to conduct
further tests, then the output should be loaded with a 11W 1kW resistor.  An input signal suitable for the
DS5 input settings should be applied and the output monitored across the load resistance.

CAUTION: The DS5 can generate output voltages of up to 160V; care should be taken to insulate all
connections and avoid coming into contact with the output voltages.  Special care should be taken to avoid
contact with both output terminals simultaneously.

Evaluation, Documentation and Preparation for Normal Use

The test results obtained should be analysed for possible non-conformance to standards and the results
recorded  in  line  with  the  policy  of  the  responsible  organisation  involved.   Should  the  records  show a
deterioration in test results the frequency of testing may need to be revised.

Assuming satisfactory test completion the DS5 may be returned to normal use.  Check that the supply
voltage selector and the supply fuses are correct for the intended site of operation.
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ANNEX 2:- Installing & Using the DS5 User Interface (DS5 UI) 
Software

IMPORTANT - The DS5 should  NOT be connected to the computer via the USB cable until the DS5 UI
software has been successfully installed.

Installation of the DS5 UI Software

The first installation of the DS5 UI Software should be carried out on a computer which has an  internet
connection, as it may be necessary for the DS5 to install a remote firmware update as part of the installation
process.  Subsequent use of the DS5 UI Software does not require an internet enabled PC.

1. Please download the LATEST version of the Digitimer DS5 UI Software Installer from the Digitimer
website (http://update.digitimer.com/DS5/software/latest/  ).    Click once on “setup.exe” and save the
file to a known location, such as the Desktop on the computer to be used with the DS5.

        

2. Double-click on setup.exe to install the DS5 UI Software.  You may see a warning that the software
publisher could not be verified, please ignore this by clicking on Run to proceed and then follow the
on-screen instructions until the installation is completed.
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3. Note that if the DS5 UI Software was already installed on this computer, the installer will ask you if
you wish to modify, repair or uninstall the previous installation.

4. Once the software is installed, the DS5 can now be connected to the computer via the supplied USB
cable and powered on.

5. WindowsTM should alert you that new hardware (Digitimer DS5) has been connected.  Please follow
the hardware installation process according to the illustrations below.

       

       

6. Once the DS5 is installed,  the DS5 UI Software can be run via the Windows Start Menu under
START > All Programs > Digitimer DS5 Control Software > DS5UI

7. Running the DS5UI opens two windows:-

(i)  The DS5 Device List  - Lists information about the DS5 connected to the computer, 
including the firmware version and serial number.
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(ii)  The DS5 Console - Control Panel/Virtual Front Panel of the DS5.

8. If the DS5 firmware is an early version it may not be supported by the latest DS5 UI Software.  In
this case, it will be necessary to update the firmware of the DS5 and this will be prompted in the
DS5 Console Window (see below).  The software will also ask you to check for updates of the DS UI
Software version before proceeding with the update.
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9. Once the firmware update has been complete, the DS5 should be powered off and back on again.
The restarted DS5 should be listed in the Device List window with the updated firmware indicated. It
should now be possible to use the DS5 UI to adjust the settings and control some features of the
DS5.

If you encounter any problems during the software/firmware update process, please contact Digitimer or
your local representative.

Using the DS5 UI Software

This section describes the features of the DS5 User Interface Software.  The DS5 UI software is started from
the Windows Start Menu using START > All Programs > Digitimer DS5 Control Software > DS5UI

Two windows are opened, the  DS5 Console and the  DS5 Device List.  The DS5 Console provides the
“vitual front panel” of the connected DS5 and the DS5 Device List, which minimizes to the Digitimer  DD
taskbar icon, provides the operator with information about the DS5 itself, including the firmware status.

DS5 Device List

Displays the serial number and certain other characteristics relating to any DS5 stimulators connected to the
computer via the USB connection.  The DS5 Device List also provides the operator with the ability to update
the DS5 UI software and configure automatic updates.

Digitimer Ltd. 40 of 53 Copyright © 2014
File Ref: N:\Docs\Company\Manuals\DS5\ISSUE-7\D125-MAN_v7.odt Last Revised: March 5, 2014



DS5 Isolated Bipolar Constant Current Stimulator DS5 Operator's Manual 7.0

In the bottom left hand corner a tick box allows the operator to configure the software to show the DS5
Console whenever a DS5 is connected to the computer (or when the Refresh action is used).  The DS5
Device List Window has three menu bar commands, Action, Updates and Help and four icons which are
described below.

Action > Show DS5 Console (Ctrl + S)

Once a DS5 is selected from the “Connected Devices” list, the Console Window can be displayed by selecting

this item from the menu bar or clicking on the Show DS5 Console icon .  It is also possible to show the

console by double-clicking on the DS5 within the device list.

Action > Refresh (Ctrl + R)

The display of “Connected Devices” can be refreshed at any time by selecting this item from the menu or

clicking on the Refresh icon .

If  the  “Automatically  show the  console  when  a  device  is  connected”  is  ticked,  the  device  list  will  be
minimized to the task bar when the refresh action is used.

Action > Exit

The DS5 UI software may be exited by selecting this option from the menu bar or clicking on the exit icon
.

Updates > Check for Software Updates...

This menu option connects to the Digitimer server and checks if there is an update available for the DS5 UI
software.

Updates > Configure Automatic Software Update Checks...

Allows the operator to set their own software update preferences.
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Help > Online Help

Opens a PDF copy of the DS5 Operators Manual.  PDF reading software such as Adobe Acrobat Reader must
be installed for this feature to work.

Help > About

Displays information about the DS5 UI sotware.  This can also be accessed via the  icon

DS5 Console

The DS5 Console provides the operator with the virtual front panel of the DS5 and is divided into three
areas.  At the top of the window is a  Menu and Toolbar which provide the operator access to relevant
settings and actions.  Under the Toolbar, is the Meters section, consisting of bar graphs and meters similar
to those present on the front panel of the DS5.  At the bottom of the window is a row of Status Indicator
Icons.  Clicking any of the Limits or Status icons within the Meters and Status sections allows the operator
to make immediate changes to the DS5 settings.  Right clicking within the Console window will display the
Control Menu which is used to load or alter previously saved DS5 settings profiles.
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Menu & Tool Bar

File > Close

Exits from the DS5UI Software.

Control Menu > Show Control Menu...

Right clicking on the Console window or selecting this  menu item displays the
Control Menu.  The Control Menu consists of an icon toolbar above a list of saved
profiles.  Clicking on a profile will activate it, sending the appropriate commands to
the DS5 via the USB connection.

The toolbar  commands are Control  Menu Editor...  ,  Menu Properties  ,

Help , About .  Each is discussed in more detail below.

Control Menu > Control Menu Editor...

When the DS5 UI is installed, the Control Menu includes one pre-defined profile, “Output OFF”, indicated by
a blue flag.  Additional profiles can be added to the list from within the Menu Editor window and these will
be given green flags.

The Menu Editor window consists of an icon toolbar, a list of saved profiles and a tabbed pane that displays
the control settings and attributes of a selected profile.  The toolbar items which are described below can
also be displayed by right-clicking anywhere within the Menu Editor Window.

Adds a new “untitled” profile to the list of profiles.

Opens the profile title for editing.

Move the highlight back (up) through the list of profiles.

Move the highlight forward (down) through the list of profiles.

Deletes the currently selected profile.

Makes the currently selected profile read-only.

Toggles display (visibility) of selected profile in the Control Menu.

Opens a PDF copy of the DS5 Operators Manual.

Displays information about the DS5 UI software.

Selected profiles can be edited by changing the status of the various tick boxes and radio buttons within the
Control Tab.  A green tick indicates that a particular state will be activated when the profile is loaded.  An
empty tick box indicates that the state will be deactivated.  If the box has a green square inside it, that state
will remain unchanged when the profile is loaded.  The Attributes tab has a comment box for adding a more
complete description of the profile as well as tick boxes to alter the profile visibility and read-only status.
The stimulator settings available for modification within the DS5 UI software are the same as those found
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within the DS5 front panel menu.  Further information on the effects these settings have is provided within
Chapter 3 of this manual, which should be consulted before this software is used.

  

Defining profiles within the DS5 UI has certain advantages -  (i) Particular stimulator settings can be quickly
defined and activated in the correct order with a single mouse click (ii)  The software is also useful in
situations where multiple profiles are needed, as these can be stored for later recall.

Once a profile has been created and defined or edited, the OK button should be selected to save and close
the Control Menu Editor.  When that profile is selected from the Control  Menu it will run with the new
settings.

Copying Profiles to another Computer

At some point the operator may wish to transfer DS5 profiles or settings to another computer.  This is easily
done by copying certain files from the hard disk of the donor computer to the same location on the recipient.
The DS5 User Interface Software should be installed on the recipient computer prior to copying of the files
to the hard disk.

Profiles C:\Documents and Settings\All Users\Application Data\Digitimer\DS5_UI\menu.bin

User Interface 
Settings

C:\Documents and Settings\<User>\Application Data\Digitimer\DS5_UI\options.bin

<User> should be replaced with the Windows Log In username of the person using the D360.

Note that the Profiles are global and are therefore accessible by all users of the computer.
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Control Menu > Menu Properties...

Allows the DS5 operator to alter the transparency of the Control Menu as well as define how Tooltips are
configured.

View > Toolbar

Toggles display of the toolbar icons.

View > Statusbar

Toggles display of the statusbar.

Updates > Check for Software Updates...

Connects to the Digitimer update server and checks if there is an update available for the DS5 UI software.

Updates > Configure Automatic Software Update Checks...

Allows the operator to set their own software update preferences.

Updates > Check for Firmware Updates...

Connects to the Digitimer update server and checks if there is an update available for the DS5 firmware.

Updates > Import Firmware Updates...

Firmware updates can be installed from a saved file rather than directly through the internet.

Help > Online Help

Opens a PDF copy of the DS5 Operators Manual.  This can also be accessed via the  icon within the

Console or Control Menu tool bars.

Help > About

Displays information about the DS5 UI software.  This can also be accessed via the   icon within the
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Console or Control menu tool bars.

Meters

The meters display provides a graphical representation of some of the stimulation parameters which the DS5
monitors continuously.  Displayed parameters include Peak Current, Peak Voltage, Average Low Current
(AvL),  Average  High  Current   (AvH),  Pulse  Energy  (PE),  Impedance  (Z),  Pulse  Duration  (PD).   Icons
displayed within the AvL, AvH, PE and PD bar graphs indicate whether the normal  or extended  output
limits are enabled.  Clicking on these icons opens a new window which allows the operator of the DS5 to
enable and disable limits.

When values are within the normal limits and these limits are enabled, the bars are coloured blue.  When
the extended limits are enabled, the bars turn amber when values are between the normal and extended
limits.  If an enabled limit is exceeded, three events will occur:- (i) The relevant bar will turn red (ii) The
green or amber shield will be replaced by a red shield with a white cross   (iii) The stimulator output will
be disabled.

Status Indicator Icons

These icons generally mirror those displayed on the DS5 front panel and provide information on the settings
and status of the DS5.  Please consult Chapter 3 of the DS5 Operators Manual for more detail.

Autozero – Under startup conditions this icon flashes displaying the “egg timer”,
indicating that the DS5 has not yet been autozeroed or that 5 minutes has elapsed
since  the  last  autzero  event.   Once  autozeroed  the  icon  ceases  to  flash  and  is
replaced with the lower of the icons shown opposite.  Autozeroing can be done via
the front panel  F2/AZ key,  activating a stored profile or  by clicking on this  icon.
Other icons equivalent to those shown in the F2 zone of the DS5 front panel can also
be displayed here, please consult the DS5 Operators Manual for more information.

Buzzer – Click to toggle the audible warning on or off.  A yellow cross through the
icon indicates the audible warning has been disabled.

Backlight – Click to turn the backlight on or off.  Turning the back-light off can
reduce electrical noise from the stimulator.  A yellow cross through the icon indicates
the backlight has been disabled.

Input (I/P Overange) – Under normal conditions, this area is blank, however, if
the input voltage range is exceeded the icon shown is displayed. Equivalent to Zone B
of the DS5 front panel

IP/OP  Range –  Shows  the  active  Input  Voltage  and  Output  Current  ranges.
Clicking on this icon open the “Range” window, allowing the operator to adjust the
input and output ranges.  Changes made here will disable the stimulator output.

Output Disabled – Click to disable the stimulator output.  The output can be re-
enabled by using the orange momentary action toggle switch on the DS5 front panel,
activating a stored profile, or by clicking on the icon.

Output Enabled – Shown when the output  has been enabled using the orange
momentary action toggle switch.  The output can be disabled by using the orange
momentary action toggle switch on the DS5 front panel, activating a stored profile, or
by clicking on the icon.

Other icons equivalent to those displayed in the F4 zone of  the DS5 front panel
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display can also appear here.  For more information on the meaning of these icons,
please consult Chapter 3 of this manual.
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ANNEX 3:- Guidance & Declarations on Electromagnetic 
Compatibility

Electromagnetic Emissions (Table 201)

The Digitimer DS5 is intended for use in the electromagnetic environment specified below. The customer
or the user of the Digitimer DS5 should assure that it is used in such an environment.

Emissions test Compliance Electromagnetic environment guidance

RF emissions

CISPR 11
Group 1

The Digitimer DS5 uses RF energy only for its 
internal function. Therefore, its RF emissions are 
very low and are not likely to cause any 
interference in nearby electronic equipment.

RF emissions

CISPR 11
Class A

Harmonic emissions

IEC 61000-3-2
Not applicable

Voltage fluctuations/ 
flicker emissions

IEC 61000-3-3
Not applicable

The Digitimer DS5 is suitable for use in all 
establishments other than domestic and those 
directly connected to the public low-voltage power
supply network that supplies buildings used for 
domestic purposes.
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Electromagnetic Immunity (Table 202)

The Digitimer DS5 is intended for use in the electromagnetic environment specified below. The customer 
or the user of the Digitimer DS5 should assure that it is used in such an environment.

Immunity test IEC 60601 test level Compliance level Electromagnetic
environment  guidance

Electrostatic discharge 
(ESD)

IEC 61000-4-2

±6 kV contact

±8 kV air

±6 kV

±8 kV

Floors should be wood, concrete or
ceramic tile. If floors are covered 
with synthetic material, the relative
humidity should be at least 30 %.

Electrical fast 
transient/burst

IEC 61000-4-4

±2 kV for power 
supply lines

±1 kV for 
input/output lines

±2 kV

±1 kV

Mains power quality should be that 
of a typical commercial or hospital 
environment.

Surge

IEC 61000-4-5

±1 kV differential 
mode

±2 kV line(s) to 
earth

±1 kV

±2 kV

Mains power quality should be that 
of a typical commercial or hospital 
environment.

Voltage dips, short 
interruptions and 
voltage variations on 
power supply input lines

IEC 61000-4-11

<5 % UT 

(>95 % dip in UT)

for 0,5 cycle

40 % UT

(60 % dip in UT)

for 5 cycles

70 % UT

(30 % dip in UT)

for 25 cycles

<5 % UT

(>95 % dip in UT)

for 5 sec

COMPLIANT

COMPLIANT

COMPLIANT

COMPLIANT

Mains power quality should be that 
of a typical commercial or hospital 
environment. If the user of the 
Digitimer DS5 requires continued 
operation during power mains 
interruptions, it is recommended 
that the Digitimer DS5 be powered 
from an uninterruptible power 
supply or a battery.

Power frequency (50/60
Hz) magnetic field

IEC 61000-4-8

3 A/m 3 A/m Power frequency magnetic fields 
should be at levels characteristic of 
a typical location in a typical 
commercial or hospital 
environment.

NOTE UT  is the a.c. mains voltage prior to application of the test level.
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Electromagnetic Immunity (Table 204)

The  Digitimer DS5 is intended for use in the electromagnetic environment specified below. The customer
or the user of the Digitimer DS5 should assure that it is used in such an environment.

Immunity test
IEC 60601 

test level
Compliance
level

Electromagnetic environment – guidance

Conducted RF

IEC 61000-4-6

Radiated RF

IEC 61000-4-3

3 Vrms

150 kHz to 80 MHz

3 V/m

80 MHz to 2,5 GHz

3 V

3 V/m

Portable  and  mobile  RF  communications
equipment should be used no closer to  any
part  of  the  Digitimer  DS5,  including  cables,
than  the  recommended  separation  distance
calculated from the equation applicable to the
frequency of the transmitter.

Recommended separation distance

d = [3,5/3] ÅP

d = [3,5/3] ÅP      80MHz to 800Mhz

d = [7/3] ÅP         800MHz to 2.5GHz

where  P is the maximum output power rating
of the transmitter in watts (W) according to the
transmitter  manufacturer  and  d  is  the
recommended separation distance in metres
(m).

Field strengths from fixed RF transmitters, as
determined  by  an  electromagnetic  site
survey,a  should be less than compliance level
in each frequency range.b

Interference  may  occur  in  the  vicinity  of
equipment marked with the following symbol:

NOTE 1 At 80 MHz and 800 MHz, the higher frequency range applies. 

NOTE 2 These guidelines may not apply in all  situations.  Electromagnetic  propagation is  affected by
absorption and reflection from structures, objects and people.
a Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and
land mobile radios, amateur radio, AM and FM radio broadcast and TV broadcast cannot be predicted
theoretically  with  accuracy.  To assess  electromagnetic  environment  due  to  fixed  RF transmitters,  an
electromagnetic site survey should be considered. If measured field strength in the location in which the
Digitimer  DS5 is  used  exceeds the applicable  compliance  level  above,  the Digitimer  DS5 should  be
observed to verify normal operation. If abnormal performance is observed, additional measures may be
necessary, such as re-orienting or relocating the Digitimer DS5. 
b Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m.
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Recommended separation distances between portable & mobile RF communications 
equipment & the Digitimer DS5 (Table 206)

The Digitimer DS5 is intended for use in an electromagnetic environment in which radiated RF 
disturbances are controlled. The customer or the user of the Digitimer DS5 can help prevent 
electromagnetic interference by maintaining a minimum distance between portable and mobile RF 
communications equipment (transmitters) and the Digitimer DS5 as recommended below, according to 
the maximum output power of the communications equipment.

Rated maximum output 
power of transmitter

(W)

Separation distance according to frequency of transmitter (m)

150 kHz to 80 MHz

d = [3,5/3] ÅP

80 MHz to 800 MHz

d = [3,5/3] ÅP

800 MHz to 2,5 Ghz

d = [7/3] ÅP

0,01 0.12 0.12 0.23

0,1 0.37 0.37 0.74

1 1.12 1.12 2.33

10 2.88 2.88 5.76

100 11.67 11.67 23.33

For transmitters rated at a maximum output power not listed above, the recommended separation 
distance d in metres (m) can be estimated using the equation applicable to the frequency of the 
transmitter, where P is the maximum output power rating of the transmitter in watts (W) according to the 
transmitter manufacturer.

NOTE 1 At 80 MHz and 800 MHz, the separation distance for the higher frequency range applies.

NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is affected by 
absorption and reflection from structures, objects and people.
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ANNEX 4:- Guidance on System Integration

The DS5 Stimulator relies for its action upon the simultaneous use of other pieces of equipment as it does
not, itself, contain a signal generator.  So, for example, when used for “threshold tracking” studies it would
be used alongside an EMG recorder and a personal computer.  The computer would be used to analyse the
signal  from the  EMG recorder  and  produce  the  stimulation  waveform from a  fitted  digital-to-analogue
interface card.  In this example the DS5 and the EMG recorder are equipment designed as Medical Electrical
Equipment, while the computer is not specifically designed as medical equipment.

Using  a  combination  of  Medical  Electrical  Equipment  (M.E.E.)  and  “non-M.E.E.”  can  introduce  hazards;
careful consideration is required of equipment choice and how it is connected together.

The use of a combination of equipment creates a “system”.  The international collateral standard IEC /(EN)
60601-1-1 “Safety Requirements for Medical Electrical  Systems” contains the requirements for continued
safety and guidance on integration.  This is  also now covered in IEC60601-1:2005 at Clause 16. Users
should familarise themselves with these requirements.

Connection of non-medical equipment into a medical system can introduce leakage (or touch) currents in
excess of that allowed for medical equipment into the patient environment.  For Users of the DS5 involved in
threshold tracking studies there are two methods by which this hazard can be eliminated.

I. Power the computer via a separation or isolation transformer.  This removes the leakage currents from
the computer circuits.

II. Keep all equipment outside the Patient Environment.  The Patient Environment is generally considered to
be the patients bed or couch and the space surrounding it, to a distance of 1.5 metres.  For the DS5 this
is easily achieved using the 4m Output Extension Lead, part  number D185-HB4.  However separate
measures would be required to move the EMG recorder outside the Patient Environment.

With either solution some other factors should also be remembered.

 Never touch the patient whilst simultaneously touching the “non-medical” parts of the system.  With
the DS5 this would extend to the BNC connectors on the rear panel.

 Using portable multiple socket outlets can introduce new risks.  They are easily damaged and a fault
in the multiple socket outlet can mean that the leakage currents of all the connected equipment
appear in the patient connected equipment.

 If  a portable multiple socket outlet must be used keep it  off  the floor (where it is  most easily
damaged).  It is better to use permanent wall mounted socket outlets.

 Never use multiple socket outlets plugged into one another (a “daisy chain”) or from an extension
lead. 

Should you be in any doubt over the correct steps to take when connecting the DS5 into a system, obtain
advice from your orginisations Bio-engineering / Medical Physics / E.B.M.E. department.  Advice may also be
obtained from Digitimer Ltd.

Digitimer Ltd. 52 of 53 Copyright © 2014
File Ref: N:\Docs\Company\Manuals\DS5\ISSUE-7\D125-MAN_v7.odt Last Revised: March 5, 2014



DS5 Isolated Bipolar Constant Current Stimulator DS5 Operator's Manual 7.0

Issue:  7
C/N:  2207
Date: 05/03/14
File Ref:  N:\Docs\Company\Manuals\DS5\ISSUE-7\D125-MAN_v7.odt

Digitimer Ltd. 53 of 53 Copyright © 2014
File Ref: N:\Docs\Company\Manuals\DS5\ISSUE-7\D125-MAN_v7.odt Last Revised: March 5, 2014


	Chapter 1 GENERAL Information
	Product Description & Intended Usage
	Precautions & Warnings
	Operator’s Manual
	Indications for Use
	Risks to Patient Safety
	Patient Exclusion Criteria
	Explosion and Fire
	High Voltages
	Damage
	Temperature
	Moisture
	Input/Output Connectors
	Electrical Interference

	Regulatory Statements
	EU Declaration of Conformity
	EN 60601-1:2006 + A1:2013 Classifications
	Environmental

	Cleaning, Maintenance & Servicing
	Modification Status
	Unpacking
	Supplied Accessories
	Optional Accessories
	Mains Connections
	Mains Plug Connections
	Mains Plug Fuse
	Mains Voltage Selector
	Mains Inlet Fuses

	Product Registration
	Why Register Your Purchase?
	How to Register Your Purchase
	Product Announcement Mailing List

	Contact Addresses
	Manufacturer
	Main Representatives

	Purchase Information
	Specifications
	Warranty Information
	Limited Warranty
	Obtaining Warranty Service
	Product change or discontinuation


	CHAPTER 2 HARDWARE Installation
	Tour of the Hardware
	Introduction
	Front Panel Components
	Front Panel Symbols
	Rear Panel Components
	Rear Panel Symbols
	Audible Alerts & Warnings

	Initial Hardware Check

	Chapter 3 Configuration AND Operation
	The Main Operating Screen
	Main Operating Screen Components & Icons

	Configuring the DS5
	Defining the Required Input Voltage Range
	Defining the Required Output Current Range
	Adjusting the Display Contrast
	Turning the LCD Backlight On and Off
	Enabling and Disabling the Audible “Information” Alerts
	Enabling and Disabling the Output Limits
	Maintenance Options

	Output Limits
	Limits and the Definition of a Pulse
	Exceeding an Enabled Limit
	Exceeding a Disabled Limit

	Hardware Connections
	Voltage Input Connection
	Monitor Output Connections
	USB Connection
	Connecting to a Dummy Load
	Patient Connection
	Selecting Appropriate Stimulation Electrodes
	Electrode Placement Protocols


	Applying a Stimulation Protocol
	Introduction
	The Autozero Function
	Enabling & Disabling the Stimulator Output
	Enabling Upon Startup
	Resetting & Re-enabling After Output Limit Error
	Terminating a Stimulation Protocol


	Bibliography

	Chapter 4 TECHNICAL ANNEXES
	ANNEX 1:- Recurrent Testing of the DS5
	Test Procedure
	Visual Inspection
	Electrical Tests
	Functional Test
	Evaluation, Documentation and Preparation for Normal Use


	ANNEX 2:- Installing & Using the DS5 User Interface (DS5 UI) Software
	Installation of the DS5 UI Software
	Using the DS5 UI Software
	DS5 Device List
	DS5 Console
	Menu & Tool Bar
	Copying Profiles to another Computer
	Meters
	Status Indicator Icons


	ANNEX 3:- Guidance & Declarations on Electromagnetic Compatibility
	Electromagnetic Emissions (Table 201)
	Electromagnetic Immunity (Table 202)
	Electromagnetic Immunity (Table 204)
	Recommended separation distances between portable & mobile RF communications equipment & the Digitimer DS5 (Table 206)

	ANNEX 4:- Guidance on System Integration


